# Table of Contents

1.0 Release Notes ................................................................. 1  
2.0 Installation Notes ........................................................... 2  
  2.1 Contents of Distribution ............................................... 2  
  2.2 Required Resources ................................................... 2  
  2.3 Before You Begin: Installation Issues ....................... 3  
3.0 Installation Instructions .................................................. 4  
  3.1 Disk Space ................................................................. 4  
  3.2 Pre-installation .......................................................... 4  
4.0 Sample Installations ....................................................... 5  
  4.1 BEDD XML/Ensemble Installation ............................ 5  
    4.1.1 Move XML Compressed File ................................. 5  
    4.1.2 Open Ensemble Studio ....................................... 5  
    4.1.3 Import the bedd0200.01.xml file ....................... 7  
  4.2 BEDD KIDS Installation ........................................... 9  
  4.3 Sample Cache Install ............................................... 10  
5.0 Application Access Setup ............................................... 16  
  5.1 Stand-Alone Setup .................................................. 16  
    5.1.1 EHR Setup ...................................................... 20  
Acronym List .................................................................... 29  
Contact Information ......................................................... 30
Preface

The purpose of this manual is to provide the user with the information required to install Version 2.0 Patch 1 of the IHS Emergency Department Dashboard (EDD).
1.0 Release Notes

The EDD is a tool that electronically enables facilities to run and manage their emergency and or urgent care clinics. The EDD is dependent on the Resource and Patient Management System (RPMS) Emergency Room System (ERS) in the AMER namespace. EDD was built on the ERS foundation to enhance patient flow and provider communication.

EDD can be set up to operate as a stand-alone icon on the staff computer or can be accessed from within the RPMS Electronic Health Record (EHR) application.

EDD gets its data and updates from one of four ways: ERS, Dashboard Edit, or EHR data or a combination of all three.
2.0 Installation Notes

Prefix: BEDD
Current Version: 2.0 Patch 1

2.1 Contents of Distribution
The BEDD v2.0 Patch 1 distribution contains the following items documented in Table 2-1.

Table 2-1: Contents of Distribution

<table>
<thead>
<tr>
<th>File</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>bedd0200.01.xml</td>
<td>Ensemble XML import file</td>
</tr>
<tr>
<td>bedd0200.01k</td>
<td>KIDS file</td>
</tr>
<tr>
<td>bedd0200.01i.pdf</td>
<td>Addendum to the Installation manual and release notes (this document)</td>
</tr>
<tr>
<td>bedd0200.01t.pdf</td>
<td>Addendum to the Technical manual</td>
</tr>
<tr>
<td>bedd0200.01a.pdf</td>
<td>Addendum to the User guide</td>
</tr>
<tr>
<td>bedd0200.01n</td>
<td>Patch notes</td>
</tr>
</tbody>
</table>

2.2 Required Resources
Table 2-2 contains the RPMS software which is required for the BEDD software to run properly.

Table 2-2: Required RPMS software

<table>
<thead>
<tr>
<th>Module</th>
<th>Minimum Version</th>
</tr>
</thead>
<tbody>
<tr>
<td>Veterans Administration (VA) FileMan (DI)</td>
<td>v22.0 Patch 1003</td>
</tr>
<tr>
<td>VA Kernel (XU)</td>
<td>v8.0 Patch 1015</td>
</tr>
<tr>
<td>IHS/VA Utilities (XB)</td>
<td>v3.0 through Patch 11</td>
</tr>
<tr>
<td>ER Visit System (AMER)</td>
<td>V3.0 Patch 8</td>
</tr>
<tr>
<td>Patient Care Component PCC Data Entry (APCD)</td>
<td>v2.0 through Patch 10</td>
</tr>
<tr>
<td>IHS PCC Suite (BJPC)</td>
<td>v2.0 Patch 11</td>
</tr>
<tr>
<td>EHR 1.1</td>
<td>v1.1 Patch 14</td>
</tr>
<tr>
<td>Lexicon Utility (LEX)</td>
<td>v2.0 Patch 1003</td>
</tr>
<tr>
<td>Ensemble</td>
<td>v2012.2.5</td>
</tr>
</tbody>
</table>
2.3 Before You Begin: Installation Issues

The Ensemble import file (bedd0200.01.xml) is being delivered in a zipped (compressed) format. It has been determined that transferring the file in an uncompressed format will corrupt it so that it will not import properly into Ensemble. Therefore, when retrieving the file, do not extract the file from its zipped state until it has been placed directly into the desired import folder. Installation Instructions
3.0 Installation Instructions

The process to install version 2.0 Patch 1 of the BEDD application requires the installation of two builds. The first build that needs to be installed is an XML release that needs to be imported into Ensemble first. Following the XML installation will be a standard KIDS build installation.

3.1 Disk Space

With Version 2.0 of BEDD Patch 1, no significant extra disk space is needed on the server to install the Cache Server Page (CSP) and Cache Class files contained in the bedd0200.01.xml file. Additional storage space will be needed to store patient information entered through the EDD.

3.2 Pre-installation

Before installing the BEDD application, the following items should be completed:

- Load the software into a test account, then into the production account (optional).
- Refer to the sample installation instructions for the applicable prompts and user responses. User responses appear in bold type.
- Ensure that the other required applications have been installed.
4.0 Sample Installations

There are two builds which need to be installed with this release; an XML build and a KIDS build. For the installation to complete successfully, the KIDS build must be installed after the XML build. A post install step in the KIDS build compiles information delivered in the XML build, so it must be installed second. If the KIDS build inadvertently gets installed first, continue and install the XML build and then install the KIDS build a second time.

For sites that use (or intend to use) the ED Dashboard in Stand-alone mode, or that have the ED Dashboard set up as a menu option within EHR to open the ED Dashboard in a new browser window, Patch 1 developers recommend that changes be made to existing desktop ED Dashboard shortcuts or the action property associated with the ED Dashboard menu option. After completing the XML and KIDS build installations, refer to Section 5.1.1 for instructions on setting up a desktop shortcut or an EHR menu option to access the ED Dashboard.

4.1 BEDD XML/Ensemble Installation

This section begins the BEDD installation process. It describes the process of importing the BEDD application into Ensemble Studio from an XML file.

4.1.1 Move XML Compressed File

Move the compressed XML build to a folder accessible by the Ensemble server. Once the file has been placed into the folder, unzip the file.

4.1.2 Open Ensemble Studio

1. Click the Ensemble cube in the system tray (at the right end of the Windows Taskbar) and click Studio, as shown in Figure 4-1. A login ID and password may be required.
2. The Ensemble Studio window is displayed in Figure 4-2.

3. On the File menu, click Change Namespace to open the Cache Connection Manager dialog box.

4. Select the appropriate namespace from the Cache Connection Manager dialog box and click OK, as shown in Figure 4-3.
4.1.3 Import the bedd0200.01.xml file

1. On the Tools menu, click Import Local as seen in Figure 4-4.

2. Navigate to the appropriate folder where the file was placed, and select bedd0200.01.xml and click Open (Figure 4-5), to display the Import dialog box, as shown in Figure 4-6.
3. In the **Import** dialog box, all items in the list need to be selected and **Compile Imported Items** options needs to be selected.

4. Click **OK**. After the system compiles the EDD package files, the “Compilation finished successfully in…” message appears in the Output pane.

5. A warning dialog box like Figure 4-7 may be displayed after the XML file has been imported. Click **OK** to continue.
4.2 BEDD KIDS Installation

1. From the KIDS menu, select the Installation menu.

2. From the XPD Main -> Installation menu, select **Option 1: Load a Distribution**.

3. Type `bedd0200.01k` at the “Enter a Host File” prompt. Please note that the file path might need to precede the file name with the appropriate host path. This is the file to retrieve from the appropriate software directory.

4. Type **Yes** (or press the ENTER key to accept the default) at the “Want to Continue with Load? YES//” prompt.

5. KIDS file `bedd0200.01k` contains the following installation file:

   **BEDD*2.0*1**

6. From the Installation menu, select **Option 2: Verify Checksums in Transport Global**. This option provides a mechanism for ensuring the integrity of your routines. This step verifies checksums for the components of the Transport global, and reports any errors uncovered.

7. Type **BEDD*2.0*1** as the install name.

   Optional: At this time, a user can elect to exercise one of the following installation options. If using one of these, type **BEDD*2.0*1** as the install name.

   a. **Back Up a Transport Global** – this option creates a MailMan message that will back up all current routines on the system that would be replaced by this release.

   b. **Compare Transport Global** – this option allows the user to view all changes that will result from the installation of this patch and compares them with the values currently loaded on the system (routines, data dictionaries, templates, etc.).

8. From the Installation menu, select the **Install Packages(s)** option.

9. At the Select Install Name prompt, type **BEDD*2.0*1**.
10. Respond to the following prompts as indicated:

a. At the “Want KIDS to Rebuild Menu Trees Upon Completion of Install? YES/" prompt, type NO.

b. At the “Want KIDS to INHIBIT LOGONs during the install?//YES” prompt, type NO.

c. At the “Want to DISABLE Scheduled Options, Menu Options and Protocols?// YES” prompt, type NO.

11. Type the name of the device that will print the install messages.

12. Exit the Installation menu.

4.3 Sample Cache Install

**Note:** User responses appear in bold type.

```
Select OPTION NAME: XPD MAIN Kernel Installation & Distribution System

   Edits and Distribution ...
   Utilities ...
   Installation ...
   Patch Monitor Main Menu ...

You have 2 PENDING ALERTS
   Enter "VA to jump to VIEW ALERTS option

You've got PRIORITY mail!

Select Kernel Installation & Distribution System Option: Installation

1        Load a Distribution
2        Verify Checksums in Transport Global
3        Print Transport Global
4        Compare Transport Global to Current System
5        Backup a Transport Global
6        Install Package(s)
         Restart Install of Package(s)
         Unload a Distribution

You have 2 PENDING ALERTS
   Enter "VA to jump to VIEW ALERTS option

You've got PRIORITY mail!

Select Installation Option: 1  Load a Distribution
Enter a Host File: D:\RPMS\bedd0200.01k *Note: A site specific path will be required here

KIDS Distribution saved on Jan 11, 2017@14:45:10
Comment: BEDD*2.0*1

This Distribution contains Transport Globals for the following Package(s): BEDD*2.0*1
```
Distribution OK!

Want to Continue with Load? YES/
Loading Distribution...

Build BEDD*2.0*1 has an Environmental Check Routine
Want to RUN the Environment Check Routine? YES/
BEDD*2.0*1
Will first run the Environment Check Routine, BEDD2P01

Use INSTALL NAME: BEDD*2.0*1 to install this Distribution.

1        Load a Distribution
2        Verify Checksums in Transport Global
3        Print Transport Global
4        Compare Transport Global to Current System
5        Backup a Transport Global
6        Install Package(s)
   Restart Install of Package(s)
   Unload a Distribution

You have PENDING ALERTS
   Enter "VA to jump to VIEW ALERTS option

Select Installation <TEST ACCOUNT> Option: 2 Verify Checksums in Transport Global
Select INSTALL NAME:   BEDD*2.0*1  Loaded from Distribution
1/11/17@14:53:01
   => BEDD*2.0*1 ;Created on Jan 11, 2017@14:45:10

This Distribution was loaded on Jan 11, 2017@14:53:01 with header of
BEDD*2.0*1 ;Created on Jan 11, 2017@14:45:10
It consisted of the following Install(s):
BEDD*2.0*1

Want each Routine Listed with Checksums: Yes/
YES
DEVICE: HOME//    Virtual

PACKAGE: BEDD*2.0*1   Jan 11, 2017 2:53 pm

------------------------------------------
BEDD2P01  Calculated    2460014
BEDDGET   Calculated    4204231
BEDDUTID  Calculated  176806670
BEDDUTIL  Calculated  165937044

4 Routines checked, 0 failed.

1        Load a Distribution
2        Verify Checksums in Transport Global
3        Print Transport Global
4. Compare Transport Global to Current System
5. Backup a Transport Global
6. Install Package(s)
   - Restart Install of Package(s)
   - Unload a Distribution

You have PENDING ALERTS
   Enter "VA to jump to VIEW ALERTS option

Select Installation <TEST ACCOUNT> Option: 6 Install Package(s)
Select INSTALL NAME: BEDD*2.0*1 Loaded from Distribution
1/11/17@14:53:01
=> BEDD*2.0*1 ;Created on Jan 11, 2017@14:45:10

This Distribution was loaded on Jan 11, 2017@14:53:01 with header of
BEDD*2.0*1 ;Created on Jan 11, 2017@14:45:10
   It consisted of the following Install(s):
   BEDD*2.0*1
Checking Install for Package BEDD*2.0*1
Will first run the Environment Check Routine, BEDD2P01

Install Questions for BEDD*2.0*1

Want KIDS to INHIBIT LOGONs during the install? NO/
Want to DISABLE Scheduled Options, Menu Options, and Protocols? NO/

Enter the Device you want to print the Install messages.
You can queue the install by enter a 'Q' at the device prompt.
Enter a '^' to abort the install.

DEVICE: HOME// Virtual

Install Started for BEDD*2.0*1:
   Jan 11, 2017@14:53:08

Build Distribution Date: Jan 11, 2017

Installing Routines:
   Jan 11, 2017@14:53:08

Installing PACKAGE COMPONENTS:

Installing SECURITY KEY
   Jan 11, 2017@14:53:08

Running Post-Install Routine: ENT^BEDD2P01
Compilation started on 01/11/2017 14:53:08 with qualifiers 'k-u'
Compiling routine : BEDD2XML.INT
Compiling routine : BEDDQFT.INT
Compiling routine : BEDDUTIS.INT
Compiling routine : BEDDUTW.INT, compiling 18 classes
Compiling class BEDD.EDConsults
Compiling class BEDD.EDDiagnosis
Compiling class BEDD.EDInjury
<table>
<thead>
<tr>
<th>Class/Method</th>
</tr>
</thead>
<tbody>
<tr>
<td>Compiling class BEDD.EDProc</td>
</tr>
<tr>
<td>Compiling class BEDD.EDRoomUse</td>
</tr>
<tr>
<td>Compiling class BEDD.EDRooms</td>
</tr>
<tr>
<td>Compiling class BEDD.EDSYSTEM</td>
</tr>
<tr>
<td>Compiling class BEDD.EDUserPreferences</td>
</tr>
<tr>
<td>Compiling class BEDD.EDWarning</td>
</tr>
<tr>
<td>Compiling class BEDDAPPL.EDMenu</td>
</tr>
<tr>
<td>Compiling class BEDDAPPL.EDRoomModel</td>
</tr>
<tr>
<td>Compiling class BEDDAPPL.EDSystemModel</td>
</tr>
<tr>
<td>Compiling class BEDDAPPL.EDWarningModel</td>
</tr>
<tr>
<td>Compiling class BEDDAPPL.EDVISIT</td>
</tr>
<tr>
<td>Compiling table BEDD.EDConsults</td>
</tr>
<tr>
<td>Compiling table BEDD.EDDiagnosis</td>
</tr>
<tr>
<td>Compiling table BEDD.EDProc</td>
</tr>
<tr>
<td>Compiling table BEDD.EDRoomUse</td>
</tr>
<tr>
<td>Compiling table BEDD.EDRooms</td>
</tr>
<tr>
<td>Compiling table BEDD.EDSYSTEM</td>
</tr>
<tr>
<td>Compiling table BEDD.EDUserPreferences</td>
</tr>
<tr>
<td>Compiling table BEDD.EDVISIT</td>
</tr>
<tr>
<td>Compiling routine BEDD.EDConsults.1</td>
</tr>
<tr>
<td>Compiling routine BEDD.EDDiagnosis.1</td>
</tr>
<tr>
<td>Compiling routine BEDD.EDInjury.1</td>
</tr>
<tr>
<td>Compiling routine BEDD.EDProc.1</td>
</tr>
<tr>
<td>Compiling routine BEDD.EDRoomUse.1</td>
</tr>
<tr>
<td>Compiling routine BEDD.EDRooms.1</td>
</tr>
<tr>
<td>Compiling routine BEDD.EDSYSTEM.1</td>
</tr>
<tr>
<td>Compiling routine BEDD.EDUserPreferences.1</td>
</tr>
<tr>
<td>Compiling routine BEDD.EDWarning.1</td>
</tr>
<tr>
<td>Compiling routine BEDDAPPL.EDMenu.1</td>
</tr>
<tr>
<td>Compiling routine BEDDAPPL.EDRoomModel.1</td>
</tr>
<tr>
<td>Compiling routine BEDDAPPL.EDSystemModel.1</td>
</tr>
<tr>
<td>Compiling routine BEDDAPPL.EDWarningModel.1</td>
</tr>
<tr>
<td>Compiling routine BEDDAPPL.EDVISIT.1</td>
</tr>
<tr>
<td>Compiling class BEDDAPPL.EDManager</td>
</tr>
<tr>
<td>Compiling class BEDDAPPL.EDRoom</td>
</tr>
<tr>
<td>Compiling class BEDDAPPL.EDSystem</td>
</tr>
<tr>
<td>Compiling class BEDDAPPL.EDWarning</td>
</tr>
<tr>
<td>Compiling class BEDDAPPL.EDVisitor</td>
</tr>
<tr>
<td>Compiling routine BEDDAPPL.EDManager.1</td>
</tr>
<tr>
<td>Compiling routine BEDDAPPL.EDRoom</td>
</tr>
<tr>
<td>Compiling routine BEDDAPPL.EDSystem.1</td>
</tr>
<tr>
<td>Compiling routine BEDDAPPL.EDWarning.1</td>
</tr>
<tr>
<td>Compiling routine BEDDAPPL.EDVisitor.1</td>
</tr>
<tr>
<td>Compiling routine BEDDAPPL.EDVISIT.1</td>
</tr>
<tr>
<td>Compiling file /csp/test9/BEDD.csp</td>
</tr>
<tr>
<td>Compiling file /csp/test9/EDDASRPT.csp</td>
</tr>
<tr>
<td>Compiling file /csp/test9/EDDDCITMRPT.csp</td>
</tr>
<tr>
<td>Compiling file /csp/test9/EDDCCLOGRPT.csp</td>
</tr>
<tr>
<td>Compiling file /csp/test9/EDDDCONS.csp</td>
</tr>
<tr>
<td>Compiling file /csp/test9/EDDDC.csp</td>
</tr>
<tr>
<td>Compiling file /csp/test9/EDDDCVID.csp</td>
</tr>
<tr>
<td>Compiling file /csp/test9/EDDDCXML.csp</td>
</tr>
<tr>
<td>Compiling file /csp/test9/EDDDLCKIT.csp</td>
</tr>
<tr>
<td>Compiling file /csp/test9/EDDDLCKREL.csp</td>
</tr>
<tr>
<td>Compiling file /csp/test9/EDDIL.csp</td>
</tr>
<tr>
<td>Compiling file /csp/test9/EDDLOGRPT.csp</td>
</tr>
<tr>
<td>Compiling file /csp/test9/EDDLOGRPTXML.csp</td>
</tr>
<tr>
<td>Compiling file /csp/test9/EDDLOGRPTXMLV.csp</td>
</tr>
<tr>
<td>Compiling file /csp/test9/EDDDILNID.csp</td>
</tr>
<tr>
<td>Compiling file /csp/test9/EDDDILNIT.csp</td>
</tr>
<tr>
<td>Compiling file /csp/test9/EDDDLCKIT.csp</td>
</tr>
<tr>
<td>Compiling file /csp/test9/EDDDLCKREL.csp</td>
</tr>
<tr>
<td>Compiling file /csp/test9/EDDINJ.csp</td>
</tr>
<tr>
<td>Compiling file /csp/test9/EDDINJNID.csp</td>
</tr>
<tr>
<td>Compiling file /csp/test9/EDDINJNIT.csp</td>
</tr>
<tr>
<td>Compiling file /csp/test9/EDDLOGRPT.csp</td>
</tr>
<tr>
<td>Compiling file /csp/test9/EDDLOGRPTXML.csp</td>
</tr>
<tr>
<td>Compiling file /csp/test9/EDDLOGRPTXMLV.csp</td>
</tr>
<tr>
<td>Compiling file /csp/test9/EDDDLCKIT.csp</td>
</tr>
<tr>
<td>Compiling file /csp/test9/EDDDLCKREL.csp</td>
</tr>
<tr>
<td>Compiling file /csp/test9/EDDLOGRPT.csp</td>
</tr>
<tr>
<td>Generating file: D:\intersystems\E3IHS\CSP\test9\BEDDAPPL.js</td>
</tr>
<tr>
<td>Generating file: D:\intersystems\E3IHS\CSP\test9\BEDDAPPL.css</td>
</tr>
<tr>
<td>Generating file: D:\intersystems\E3IHS\CSP\test9\BEDDAPPL_3.css</td>
</tr>
<tr>
<td>Compiling class BEDDAPPL.EDManager</td>
</tr>
<tr>
<td>Class/Method</td>
</tr>
<tr>
<td>Compiling class BEDDAPPL.EDRoom</td>
</tr>
<tr>
<td>Compiling class BEDDAPPL.EDSystem</td>
</tr>
<tr>
<td>Compiling class BEDDAPPL.EDWarning</td>
</tr>
<tr>
<td>Compiling class BEDDAPPL.EDVisitor</td>
</tr>
<tr>
<td>Compiling routine BEDDAPPL.EDManager.1</td>
</tr>
<tr>
<td>Compiling routine BEDDAPPL.EDRoom</td>
</tr>
<tr>
<td>Compiling routine BEDDAPPL.EDSystem.1</td>
</tr>
<tr>
<td>Compiling routine BEDDAPPL.EDWarning.1</td>
</tr>
<tr>
<td>Compiling routine BEDDAPPL.EDVisitor.1</td>
</tr>
<tr>
<td>Compiling routine BEDDAPPL.EDVISIT.1</td>
</tr>
<tr>
<td>Compiling file /csp/test9/EDD.csp</td>
</tr>
<tr>
<td>Compiling file /csp/test9/EDDASRPT.csp</td>
</tr>
<tr>
<td>Compiling file /csp/test9/EDDDCITMRPT.csp</td>
</tr>
<tr>
<td>Compiling file /csp/test9/EDDCCLOGRPT.csp</td>
</tr>
<tr>
<td>Compiling file /csp/test9/EDDDCONS.csp</td>
</tr>
<tr>
<td>Compiling file /csp/test9/EDDDC.csp</td>
</tr>
<tr>
<td>Compiling file /csp/test9/EDDDCVID.csp</td>
</tr>
<tr>
<td>Compiling file /csp/test9/EDDDLCKIT.csp</td>
</tr>
<tr>
<td>Compiling file /csp/test9/EDDDLCKREL.csp</td>
</tr>
<tr>
<td>Compiling file /csp/test9/EDDINJ.csp</td>
</tr>
<tr>
<td>Compiling file /csp/test9/EDDINJNID.csp</td>
</tr>
<tr>
<td>Compiling file /csp/test9/EDDINJNIT.csp</td>
</tr>
<tr>
<td>Compiling file /csp/test9/EDDLOGRPT.csp</td>
</tr>
<tr>
<td>Generating file: D:\intersystems\E3IHS\CSP\test9\BEDDAPPL.js</td>
</tr>
<tr>
<td>Generating file: D:\intersystems\E3IHS\CSP\test9\BEDDAPPL.css</td>
</tr>
<tr>
<td>Generating file: D:\intersystems\E3IHS\CSP\test9\BEDDAPPL_3.css</td>
</tr>
</tbody>
</table>
Compiling file /csp/test9/BEDDLogin.csp
Compiling file /csp/test9/BEDDLogin1.csp
Compiling file /csp/test9/BEDDPROC.csp
Compiling file /csp/test9/BEDDRMTMRPT.csp
Compiling file /csp/test9/BEDDRPTMNU.csp
Compiling file /csp/test9/BEDDTRG.csp
Compiling file /csp/test9/BEDDUA.csp
Compiling file /csp/test9/BEDDUNLOCK.csp, compiling 24 classes
Compiling class csp.bedd
Compiling class csp.beddasrpt
Compiling class csp.beddcitmtrpt
Compiling class csp.beddclogrpt
Compiling class csp.bedddcons
Compiling class csp.bedddc
Compiling class csp.bedddctmrpt
Compiling class csp.beddddiag
Compiling class csp.beddedc
Compiling class csp.beddedcv
Compiling class csp.beddedit1
Compiling class csp.beddil
Compiling class csp.beddinj
Compiling class csp.beddlckit
Compiling class csp.beddlckrel
Compiling class csp.bedddlogin
Compiling class csp.bedddlogin1
Compiling class csp.bedddosrpt
Compiling class csp.beddproc
Compiling class csp.beddrmtmrpt
Compiling class csp.beddrptmnu
Compiling class csp.beddtrg
Compiling class csp.beddua
Compiling class csp.beddunlock
Compiling routine csp.bedd.1
Compiling routine csp.beddasrpt.1
Compiling routine csp.beddcitmtrpt.1
Compiling routine csp.beddclogrpt.1
Compiling routine csp.bedddcons.1
Compiling routine csp.bedddc.1
Compiling routine csp.bedddctmrpt.1
Compiling routine csp.beddddiag.1
Compiling routine csp.beddedc.1
Compiling routine csp.beddedcv.1
Compiling routine csp.beddedit1.1
Compiling routine csp.beddil.1
Compiling routine csp.beddinj.1
Compiling routine csp.beddlckit.1
Compiling routine csp.beddlckrel.1
Compiling routine csp.bedddlogin.1
Compiling routine csp.bedddlogin1.1
Compiling routine csp.bedddosrpt.1
Compiling routine csp.beddproc.1
Compiling routine csp.beddrmtmrpt.1
Compilation started on 01/11/2017 14:53:22 with qualifiers 'k-u'
Compilation finished successfully in 13.87s.
Compiling routine : BEDDUTIS.INT
Compiling routine : BEDDUTW.INT
Compiling routine : BEDDUTW1.INT, compiling 6 classes
Compiling class BEDD.EDSYSTEM
Compiling class BEDD.EDUserPreferences
Compiling class BEDD.EDVISIT
Compiling class BEDDAPPL.EDMenu
Compiling class BEDDAPPL.EDSystemModel
Compiling table BEDD.EDSYSTEM
Compiling table BEDD.EDUserPreferences
Compiling table BEDD.EDVISIT
Compiling routine BEDD.EDSYSTEM.1
Compiling routine BEDD.EDUserPreferences.1
Compiling routine BEDD.EDVISIT.1
Compiling routine BEDDAPPL.EDMenu.1
Compiling routine BEDDAPPL.EDSystemModel.1
Generating file: D:\intersystems\E3IHS\CSP\test9\BEDDAPPL.js
Generating file: D:\intersystems\E3IHS\CSP\test9\BEDDAPPL_3.css
Compiling class BEDDAPPL.EDSystem
Compiling routine BEDDAPPL.EDSystem.1
Compiling file /csp/test9/BEDD.csp
Compiling file /csp/test9/BEDDEDIT1.csp
Compiling file /csp/test9/BEDDLCKIT.csp
Compiling file /csp/test9/BEDDLCKREL.csp
Compiling file /csp/test9/BEDDLogin1.csp
Compiling file /csp/test9/BEDDPROC.csp, compiling 6 classes
Compiling class csp.bedd
Compiling class csp.beddedit1
Compiling class csp.beddlckit
Compiling class csp.beddlckrel
Compiling class csp.beddlogin1
Compiling class csp.beddproc
Compiling routine csp.bedd.1
Compiling routine csp.beddedit1.1
Compiling routine csp.beddlckit.1
Compiling routine csp.beddlckrel.1
Compiling routine csp.beddlogin1.1
Compiling routine csp.beddproc.1
Compilation finished successfully in 5.118s.

Compilation started on 01/11/2017 14:53:27 with qualifiers 'k-u'
Compilation finished successfully in 0.005s.

Updating Routine file...
Updating KIDS files...
BEDD*2.0*1 Installed.
    Jan 11, 2017@14:53:27
Not a VA primary domain

Install Completed
5.0 Application Access Setup

There are two modes of operation for the EDD: Standalone and EHR Portal.

1. **Stand-alone Mode** - access via a direct web browser session which requires active RPMS Access and Verify codes to login.

   **Note**: The setup for this step has changed from what was done for previous BEDD releases. Existing links to the EDD will need to be deleted and replaced with the new links described below.

2. **EHR Application Access** – There are now two ways to set up the EDD to work from within the EHR Application. The EDD can be set up from within EHR as a separate tab, or it can be set up as a menu option. When the menu option is selected, it will open the EDD in a separate browser window. Note that this also requires an active RPMS Access and Verify code and the appropriate BEDD security keys to login.

5.1 Stand-Alone Setup

For Stand-alone access, a desktop icon should be created for the program to call up a web browser for access:

1. If there is already a shortcut on the desktop for the ED Dashboard, right-click on the shortcut icon and select **properties**. On the **Shortcut** tab, copy the string located in the **Target** field for later use.

2. On the desktop or from the **Start** menu, right-click on the Internet Explorer icon and choose **Send to > Desktop** (create shortcut) (Figure 5-1):
3. Locate the new shortcut on the desktop, right click and select properties. Navigate to the General tab and change the name of the shortcut to the desired value (see Figure 5-2).
4. Navigate to the **Shortcut tab**. In the **target** field (leaving what is currently listed there and appending to the end), add the following:

- Type a **space** followed by `-nomerge` (do not copy and paste this information into the link. Instead type it by hand)
- A **space** followed by the target information copied in Step 1 above. If a Standalone shortcut was not previously set up, this string will be as follows:

  ```
  http://IPADDRESS:PORT/csp/bedd/BEDDLogin.csp
  ```

  Where:

  **IPADDRESS** is the IP name or Address of your Ensemble installation or CSP Gateway

  **PORT** is the port number used for the portal or gateway

  **Note:** Modify the URL to HTTPS if you are using a CSP gateway with an active and signed HTTPS encryption certificate.

- The resulting Target value should look similar to the following example (See Figure 5-3):
"C:\Program Files\Internet Explorer\iexplore.exe" -nomerge http://URL:PORT/csp/test9/BEDDLogin.csp
Where URL and PORT represent the proper values for your site.

Figure 5-3: Updated Target field

5. Click OK to save the changes.

6. Click the new icon to test. Depending on the Ensemble settings, one of the following two pages shown in Figure 5-4 or Figure 5-5 should be presented:
   - Ensemble Login Credential Request (Figure 5-4) – Log into Ensemble with the appropriate login User Name and Password.
Figure 5-4: Ensemble Login Request

- ED Dashboard Login Credential Request (Figure 5-5) – Log into the ED Dashboard using your personal ACCESS/VERIFY codes or the Whiteboard login credentials.

Figure 5-5: ED Dashboard Login Request

5.1.1 EHR Setup

EHR application managers can choose which method they would like to allow users to view the EDD from the EHR application.

5.1.1.1 EDD New EHR Tab Method

To set up users to access the EDD from within EHR on a new EHR tab, perform the following steps:

1. Open EHR, right-click in the title bar at the top and choose Design Mode as indicated in Figure 5-6.
2. From the **Design** menu option, select **Layout Manager** (Figure 5-7.)

3. In the **Layout Manager**, click on **Tabbed Notebook** and click **Properties**, as shown in Figure 5-8:
4. In the Tabbed Notebook dialog, click on the plus (+) icon in the Tab Editor property as shown in Figure 5-9:

Figure 5-9 Create ED Dashboard Tab (Figure 2 of 3)

5. In the new tab, type **ED Dashboard** (or whatever name is to be used for the ED Dashboard) as shown in Figure 5-10:
6. After creating the new tab, step to the tab. Right-click on the **tab space** and select **Add Object** as shown in Figure 5-11:
7. Select to add a new Internet Explorer object as shown in Figure 5-12:

8. Right click on the new Internet Explorer object and select **Properties** as shown in Figure 5-13:
9. In the HOMEPAGE property box, put in the **EHR URL** as seen in Figure 5-14, where an example value is given. Replace IP address and PORT values with those appropriate for your site.

```
http://IPaddress:PORT
csp/bedd/BEDDDLogin.csp?DUZ=$(user.handle)&SITE=$(site.handle)&LOC=EHR
```

**Figure 5-13: Selecting Internet Explorer Properties**

**Figure 5-14: Enter the ED Dashboard Homepage**

### 5.1.1.2 EDD New EHR Menu Method

To set up users to access the EDD from a new browser window accessible from a menu option in EHR, perform the following steps:
1. Open EHR, right-click in the title bar at the top and choose **Design Mode** as indicated in Figure 5-15.

![Figure 5-15: Enter design mode](image)

1. Select **Design -> Desktop Properties**, as displayed in Figure 5-16.

![Figure 5-16: Desktop Properties](image)

2. Select **Customize Menus**, as displayed in Figure 5-17. Click the plus sign (+) to add and enter a new menu option **ED Dashboard**, as seen in Figure 5-18.

![Figure 5-17: Customize Menus](image)
3. Click the lightning bolt icon in the display. In the Edit Action box that appears, put in the **path to Internet Explorer followed by a space, -nomerge, another space followed by the regular EHR URL**, as seen in Figure 5-19, where an example value is given. **Replace IP address and PORT values with those appropriate for your site.**

   C:\Program Files\Internet Explorer\iexplore.exe -nomerge http://IPaddress:PORT\csp/bedd/BEDDLogin.csp?DUZ=$(user.handle)&SITE=$(site.handle)&LOC=EHR
4. Click **OK, Save Settings** and leave Design Mode.

Click on the new menu option **ED Dashboard**, and the EDD main screen will display as indicated in Figure 5-20.

Figure 5-20: ED Dashboard Display
## Acronym List

<table>
<thead>
<tr>
<th>Acronym</th>
<th>Term Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>CSP</td>
<td>Cache Server Page</td>
</tr>
<tr>
<td>ED</td>
<td>Emergency Department</td>
</tr>
<tr>
<td>EDD</td>
<td>Emergency Department Dashboard</td>
</tr>
<tr>
<td>EHR</td>
<td>Electronic Health Record</td>
</tr>
<tr>
<td>ERS</td>
<td>Emergency Room System</td>
</tr>
<tr>
<td>HTTPS</td>
<td>Hypertext Transfer Protocol Secure</td>
</tr>
<tr>
<td>IHS</td>
<td>Indian Health Service</td>
</tr>
<tr>
<td>KIDS</td>
<td>Kernel Installation and Distribution System</td>
</tr>
<tr>
<td>PCC</td>
<td>Primary Care Component</td>
</tr>
<tr>
<td>RPMS</td>
<td>Resource and Patient Management System</td>
</tr>
<tr>
<td>VA</td>
<td>Veterans Administration</td>
</tr>
<tr>
<td>URL</td>
<td>Universal Resource Locator</td>
</tr>
<tr>
<td>XML</td>
<td>Extensible Markup Language</td>
</tr>
</tbody>
</table>
Contact Information

If you have any questions or comments regarding this distribution, please contact the OIT Help Desk (IHS).

Phone:  (888) 830-7280 (toll free)
Web:  http://www.ihs.gov/helpdesk/
Email:  support@ihs.gov